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Login 
 

Access to the Property Contractor Portal is through the iSupplier Portal on the 

Lancashire County Council website.  

 

 Enter your Oracle username and password. Your username is normally the 

email address you used when registering for the iSupplier Portal. 

 Click the Login button. 

 

 Click the LCC Property Contractor Portal link. 

 

 Enter your username and password. Your username will be the same in both 

Oracle and the Contractor Portal. 

 Click the Submit button to be taken to the LCC Property Contractor Portal 

Home Page. 

http://www3.lancashire.gov.uk/corporate/web/?siteid=6864&pageid=41137&e=e
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 From here you can access your instructions, inspections and invoices. 

 

Passwords  

 Keep your password confidential; 

 Passwords are case sensitive for additional security, so if you enter your 

password for the first time in lower case (i.e. no capital letters), you will always 

have to enter it in lower case; 

 Passwords must be a minimum of 9 characters; 

 Passwords must contain at least one letter and at least one number; 

 Passwords should not contain the username; 

 To make a strong password, you should use a mixture of upper-case and 

lower-case letters, numbers, punctuation marks and symbols. 

 

Forgotten Password / First Time Log In 

 This procedure is used to set your password the first time you log in and also 

if you forget your password. 

 

 Click the forgotten password link underneath the login. 
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 Enter your username (normally your email address at the time of registration). 

 Click the Submit button. 

 A temporary password link will now be sent to your registered email address. 

 

 Click the link in the Forgotten Password email. 

 

 You will be taken to a screen where you must enter and confirm your new 

password. 

o This password will then be used to log into the Contractor portal and is 

separate to your Oracle password and LCC Secure Web Mail 

password. 

 Click the Submit button. 

 Your password has now been changed and you are taken to the login screen. 

 Log in using your username and the password you have just created. 

 If you are having difficulty resetting your password, please contact the 

iSupplier helpline on 01772 534966 (option 4). 



 LCC Property Contractor Guide 

27 June 2016 Page 6 of 33 

General Navigation 
 

 On logging into the Contractor Portal you will be taken to the Home Page. 

 

 Modules are displayed at the top of the screen. 

 Four menus may be displayed in the sidebar on the left of the screen. The 

menu options are determined by the current record. 

 

View Menu 

The View menu in the sidebar on the left of the screen provides a link 

to screens or documents, associated with the record or screen 

currently being viewed. The following number (in brackets) identifies 

the number of records or documents available.  

Actions Menu 

The Actions menu in the sidebar on the left of the screen allows you to 

carry out an action for the current record. For example, you may add a 

Note or a New Document  

 

Recent Items 

Recent Items in the sidebar on the left of the screen allows you to 

return to a screen or document you have accessed recently.  

Links 

The Links menu in the sidebar on the left of the screen contains useful 

links to other screens.  
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Once you have carried out a search, the options meeting the search criteria will be 

displayed below. 

 

 Click on one of the headings to reorder the search results by that category. An 

arrow will identify the header and the order (e.g. ascending ↑). Click on the 

heading to reorder (e.g. descending ↓) 

 The number of items found in the search will be identified; 12 items will 

normally be shown on each screen. Change the number of items displayed 

using the drop down list. The maximum number of items which can be 

selected is 72. 

 Click on Next or Prev to go to the next or previous screen, or click on the 

screen number. 

 

 

Home: contains a calendar which shows all work allocated to your organisation that 

is due in a given period.  

 The bottom of the screen shows overdue inspections and instructions. 

 Click the Edit or the Code to be taken to the record. 
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Property: contains all LCC establishments. An Instruction or Inspection will include 

a link to a property, or alternatively, use the filter to search for a property.  

 View buildings or rooms within the property by clicking on the relevant link in 

the View menu on the left of the screen. 

 

Finance: includes all your work instructions and invoices. 

 Instructions sub menu lists your open instructions. 

o Click on the Edit or the Code link to be taken to the relevant instruction. 

o This will give details of the work required, the target completion date 

and the site at which the work is to be carried out. 

o Alternatively, click the Show Filter button to search for a specific 

instruction, or set of instructions. 
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o Click on the relevant link in the View menu (on the left of the screen) 

for further options. 

 Click the Invoices sub menu to view your invoices. 

 

 A list of your invoices is displayed. Click on the Edit or the Invoice No link to 

view the details. 

 When your invoice is approved for payment, the Status and Authorisation are 

both Approved. Go to the Oracle iSupplier Portal to view payment details. 

 

Assessment: contains information relating to asbestos. 

 Search for a property to view the asbestos register. 

o You must clear your organisation name from the Owner field to 

successfully search for the asbestos records. 

 Click the View or the Code link to see the full details. 
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 Click Print Survey in the Actions menu to view the Asbestos Report. 

 Alternatively, click the relevant link in the View menu, e.g. click Locations to 

see where asbestos has been found or is suspected. 

The Asbestos Assessment module is designed to survey properties for the presence 

or absence of asbestos within them. It contains a risk analysis to measure the risk to 

the users of a property and a method of registering samples and asbestos containing 

materials at the property. 

 Buildings or rooms with asbestos containing materials (ACM) present 

(or suspected ACMs) will be identified by the asbestos warning icon.  

 This icon will be displayed against all relevant records, including 

instructions and inspections. 

 The icon is displayed against the building and all rooms within the building, 

even if asbestos is only found or suspected in one room. 

To ensure all work is completed safely, view the asbestos details in the 

Assessment module to check the details and location of ACMs before any 

work is started.  

 

Please note; the current guidance from the Health & Safety Executive (HSE) 

requires that any areas which cannot be inspected during an asbestos survey, must 

be recorded that asbestos is presumed to be present.  
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Searches (Filters) 
 

Filters are used to search for specific information or records. A filter is available in 

each module, but the information to be entered for each is different.  

 

 Select the required screen and if the search function is not displayed, click the 

Show Filter button. 

 

Enter information into one or several of the fields to find the details required. 

 Enter the search information into text fields. 

 Use drop down lists to select information.  

 Use the magnifying glass or the Find button to  

search for and select information.  

 Use calendars to select dates.  

 Use links to select further options.  

 

 You may find it useful to search by Location, Target Dates and / or the Status. 

Please note; all search fields are optional. 

o For example, you may click the Next 7 Days link to search for all work 

instructions due in the next 7 days. 
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o You may change the Status to Complete to view work you have 

marked as completed. 

o You may search for the name of an establishment by entering the 

name or partial name in the Location field or click the Find button to 

start your search. 

o All sites will be displayed in the format "Town Site Name". 

o If required, use % to separate words or to replace missing characters 

or words. E.g.to search for a library in Read, enter 'read%library'. 

o The % can be used as a separator in the address field for a post code 

e.g. enter PR1%0LD 

 

 Click the Apply Filter button to search for the site. 

 Results matching your search will be displayed. 

 To choose a site, click the Select link. 

 You will be returned to the original search screen and the establishment name 

will be displayed. 
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 Add further search information if required. 

 When all the search criteria have been entered, click the Apply Filter button to 

start the search (or to clear the current search criteria, click the Clear button 

and start a new search). 

 You may need to scroll down the page or hide the filter to view the search 

results. 

 

 Your search result will be displayed. Click the Edit or Code link to view the full 

details or start a new search. 
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Documents, Notes and Images 
  

Documents, notes and images may be added to a record to provide additional 

information to the contractor or from the contractor to the County Council. 

  

Contractors must add a copy of their invoice when submitting the invoice online. 

Contractors should also add inspection paperwork and relevant certificates as 

documents. 

  

Add Document 

 Images, notes or documents can be added to a record to provide additional 

information to other users of the system. 

 Search for and select the record the document is to be added to.  

 

 Click the New Document link in the Actions menu on the left hand side of the 

screen. 
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 Click the Browse button; search for and select the document to be uploaded. 

 

 Click the Open button to select the document. 
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 The filepath for the uploaded document is displayed and you must now enter 

the Description and Group. 

o Please Note: Do not try to save the screen until the Group has been 

added. The system will produce an error and the file in the filepath will 

disappear. You will then have to search for and select the document 

again. 

 You must enter a description of the document. This may be the file name or a 

description of the document. 

o Once added, you can search for the document by the description or 

part description. 

 Click the Group dropdown list to select the category for the document. 

 Add comments if required. 

 Review the details and click the Save button. 

 Please note: Next review date; Review owner and Archived fields should 

be blank. 
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 Confirmation that the document has been successfully uploaded is displayed 

at the top of the screen. 

 To view the saved document, click the Documents link in the View menu on 

the sidebar.  

o The number of documents attached to this record is shown in brackets. 

 

 The attached documents are listed below the Instruction Details in the 

Document List section. 

 Click the Extract link and then open the document you wish to view. 
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Notes and Images 

 

A note or image can be added to any type of record. For invoices over £200, an 

image of the completed work may be required, and if so, it should be submitted with 

the invoice using the notes and images function. 

 

 Click the New Note link. 

 

 Notes are added below the Instruction Details in the Note Details section. 
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 Click the Type dropdown list. 

o GEN - General; always select this option. Do not select Call Back. 

 Enter your note into the Detail field. 

 Private Note - always select No to enable the note to be seen by the County 

Council system users. 

 You also have the option to add an image at this stage. To add an image, 

click the Browse button. 
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 Search for and select the image. 

 Click the Open button. 

 

 The filepath is now shown in the File field. 

 Once the details are complete, click the Save button. 

 

 The message at the top of the screen confirms the note has been added 

successfully. 

 To view the note, click the Notes link. The number of notes attached to this 

record is identified by the number in the brackets. 
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 Scroll down to view the notes and images. 
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Work Instructions 
 

Work Instructions will be issued to the contractor with details of the work required 

and the target date for completion. The contractor will be notified by email that a 

work instruction has been issued.  

  

If you are unable to complete the work within the agreed costs or required timescale, 

please contact the District Surveyor, who will be identified on the order. 

 

To view a work instruction and the details of the site at which the work is to be 

carried out. 

 

 Work instructions can be seen on the calendar on the home page. These will 

start with 'INT'. 

 Click on the link in the calendar to view the work instruction, or alternatively, 

click the Finance link in the green title bar at the top of the page. 
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 A list of your open instructions is displayed. 

 The Instruction List includes a summary of the requirements and details of the 

site at which the work is to be carried out. 

 Click the relevant Edit link or the Instruction Code. 

o If the required instruction is not displayed, click the Show Filter button 

to search for it. 

 

 Full details of the work instruction are displayed. 
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o This includes the target date for completion, the site and the 

description of the work required. 

o Reminder: check the View menu for notes and documents associated 

with the instruction. 

 To view the full site address, click in the Site field. 

 

 This opens the field up to give the full address. 

o To view further site details hold down the [Ctrl] key on your keyboard 

and click in the View field. This opens the Site screen in a separate 

window to allow you to return to the instruction easily. 

o The Site screen displays a summary of the buildings and rooms within 

the site. 
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Confirm Work Completed 
 

Unless this is an interim payment (agreed by the County Council), the work must be 

marked as completed before the invoice is submitted. 

 

 Search for and select the instruction. 

 

 Click the Change Status link in the Actions menu on the left of the screen. 
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 Click the Status dropdown list and change the Status to Completed. 

 The completion date and time will default to the time that you complete this 

screen, but can be overwritten if required. 

 Add Comments if required. 

 When the details have been completed, click the Save button. 

 

 Confirmation that the status has been changed is displayed at the top of the 

screen. The invoice can now be submitted. 
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Invoicing 
  

To submit an invoice for payment: 

 Unless this is an interim payment (agreed by the County Council), the 

Instruction Status must be changed to Completed to confirm the work has 

been completed. 

 The Invoice must be raised against the Work Instruction. 

 An uneditable copy (e.g. PDF format) of the invoice and any supporting 

invoices must be added as Documents. 

 If the value of the invoice is more than £200, you may be requested to add an 

image of the completed work. 

 Once the invoice is raised and all attachments added, the Invoice Status must 

be changed to Registered. If the status is not changed to registered, the 

invoice cannot be paid.  

  

Rejected Invoices 

  

An invoice may be rejected by the County Council, e.g. if the copy of the invoice is 

not attached, or if the details on the copy invoice do not match the details on screen, 

or if a CIS breakdown is required but has not been provided. 

  

If the invoice is rejected, you will receive an email to notify you. The invoice will then 

need to be completed again, documents and images added and the status changed, 

in the same way as when submitting a new invoice. 

  

The invoice number must be unique even if your invoice is rejected and you are 

submitting a revised invoice. 

In this case, you may wish to use the original invoice number, but adding a character 

to make the number unique. 

  



 LCC Property Contractor Guide 

27 June 2016 Page 28 of 33 

Credit Notes 

  

A credit note is raised in the same way as an invoice. Select the Type 'Credit Note' to 

identify that you are raising a Credit Note. The value is always a positive amount. 

  

You cannot raise an online credit note for an invoice which has been paid or is 

pending payment. In this case, please raise a manual credit note. 

 

Raise Invoice/Credit Note  

 

 The invoice is raised from the instruction. 

 Unless this is an interim payment, the Status should be Completed. 

 From the Instruction, click the Add Invoice link. 
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 Type: Identify if you are raising an Invoice or a Credit Note.  

 Invoice No: Enter your invoice number. 

o Every invoice submitted must have a unique number; do not use the 

same number twice, even for the same instruction. 

 CIS Applies: Contractors who are Construction Industry Scheme (CIS) 

registered are responsible for flagging each invoice as CIS applicable if 

appropriate. 

o Contractors who are not CIS registered will leave as No. 

 Tax Date: Use the calendar to select the Tax date. 

 Description: Enter a description.  

 Click the scrollbar to continue. 
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 Enter the correct values into the relevant fields in the Actuals section. 

o Leave blank any fields that are not relevant. 

o Do not enter negative amounts; if a credit is due, select Credit Note at 

the top of the screen. 

 Labour (£): Enter the cost for labour.  

 Material (£): Enter the cost for materials. 

 Other (£): Enter any additional costs. 

 The VAT, Net and Gross Totals are automatically calculated. 

 VAT (£): The VAT defaults to Standard; use the drop down list to change the 

tax classification if required. 

 Final Payment: Specify if this is the Final Payment (no further invoices to be 

issued against this work instruction).  

o Select 'No' if further invoices will be issued. 

 Check the invoice details and if correct, click the Save button. 
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 Confirmation that the invoice details have been added is displayed at the top 

of the screen. 

 You must now add an uneditable copy of your invoice. Any additional invoices 

(e.g. covering plant hire etc.) must also be attached. You can add multiple 

attachments if required. 

 Please note: your invoice submission will be rejected if you do not add 

the copy of the invoice. If your invoice is rejected, you will be required to 

repeat the entire invoice submission process including adding the 

relevant attachments. 

 If your invoice is over £200, you may also be required to add an image of the 

completed work. 
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Change Invoice Status 

 

Once all attachments have been added to the invoice, change the Status to 

Registered. 

 

Changing the Status submits the invoice for payment; if you do not change the 

status, the invoice cannot be paid. 

 

 From the invoice screen, click the Change Status link on the left hand side of 

the screen. 
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 Click the Status dropdown list. 

 Always change the status from Draft to REG - Registered. 

o Please take care not to select Rejected status in error, as if the Status 

is set to Rejected, you would have to restart the submission process. 

 The date and time default. Add Comments if required. 

 When the details are correct, click the Save button. 

 

 Confirmation that the invoice status has been updated is displayed. 

 The invoice and attached documents and images can now be seen by the 

County Council. 

 Only invoices with the Status of Registered can be processed for payment. 

 


